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Notice
While reasonable efforts were made to ensure that the information in this 
document was complete and accurate at the time of printing, Avaya Inc. can 
assume no liability for any errors. Changes and corrections to the information 
in this document might be incorporated in future releases.

Documentation disclaimer
Avaya Inc. is not responsible for any modifications, additions, or deletions to 
the original published version of this documentation unless such modifications, 
additions, or deletions were performed by Avaya. Customer and/or End User 
agree to indemnify and hold harmless Avaya, Avaya's agents, servants and 
employees against all claims, lawsuits, demands and judgments arising out of, 
or in connection with, subsequent modifications, additions or deletions to this 
documentation to the extent made by the Customer or End User. 

Link disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked Web 
sites referenced elsewhere within this documentation, and Avaya does not 
necessarily endorse the products, services, or information described or offered 
within them. We cannot guarantee that these links work all the time and we 
have no control over the availability of the linked pages.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to your sales 
agreement to establish the terms of the limited warranty. In addition, Avaya’s 
standard warranty language, as well as information regarding support for this 
product, while under warranty, is available through the Avaya Support Web 
site:
http://www.avaya.com/support 

License
USE OR INSTALLATION OF THE PRODUCT INDICATES THE END USER'S 
ACCEPTANCE OF THE TERMS SET FORTH HEREIN AND THE GENERAL 
LICENSE TERMS AVAILABLE ON THE AVAYA WEB SITE 
http://support.avaya.com/LicenseInfo/ ("GENERAL LICENSE TERMS"). IF 
YOU DO NOT WISH TO BE BOUND BY THESE TERMS, YOU MUST 
RETURN THE PRODUCT(S) TO THE POINT OF PURCHASE WITHIN TEN 
(10) DAYS OF DELIVERY FOR A REFUND OR CREDIT.
Avaya grants End User a license within the scope of the license types 
described below. The applicable number of licenses and units of capacity for 
which the license is granted will be one (1), unless a different number of 
licenses or units of capacity is specified in the Documentation or other 
materials available to End User. "Designated Processor" means a single 
stand-alone computing device. "Server" means a Designated Processor that 
hosts a software application to be accessed by multiple users. "Software" 
means the computer programs in object code, originally licensed by Avaya and 
ultimately utilized by End User, whether as stand-alone Products or 
pre-installed on Hardware. "Hardware" means the standard hardware 
Products, originally sold by Avaya and ultimately utilized by End User. 

License Type(s)
Designated System(s) License (DS). End User may install and use each 
copy of the Software on only one Designated Processor, unless a different 
number of Designated Processors is indicated in the Documentation or other 
materials available to End User. Avaya may require the Designated 
Processor(s) to be identified by type, serial number, feature key, location or 
other specific designation, or to be provided by End User to Avaya through 
electronic means established by Avaya specifically for this purpose.
Concurrent User License (CU). End User may install and use the Software on 
multiple Designated Processors or one or more Servers, so long as only the 
licensed number of Units are accessing and using the Software at any given 
time. A "Unit" means the unit on which Avaya, at its sole discretion, bases the 
pricing of its licenses and can be, without limitation, an agent, port or user, an 
e-mail or voice mail account in the name of a person or corporate function 
(e.g., webmaster or helpdesk), or a directory entry in the administrative 
database utilized by the Product that permits one user to interface with the 
Software. Units may be linked to a specific, identified Server.
CPU License (CP). End User may install and use each copy of the Software 
on a number of Servers up to the number indicated by Avaya provided that the 
performance capacity of the Server(s) does not exceed the performance 
capacity specified for the Software. End User may not re-install or operate the 
Software on Server(s) with a larger performance capacity without Avaya's prior 
consent and payment of an upgrade fee. 
Named User License (NU). Customer may: (i) install and use the Software on 
a single Designated Processor or Server per authorized Named User (defined 
below); or (ii) install and use the Software on a Server so long as only 
authorized Named Users access and use the Software. "Named User," means 
a user or device that has been expressly authorized by Avaya to access and 
use the Software. At Avaya's sole discretion, a "Named User" may be, without 
limitation, designated by name, corporate function (e.g., webmaster or 
helpdesk), an e-mail or voice mail account in the name of a person or corporate 

function, or a directory entry in the administrative database utilized by the 
Product that permits one user to interface with the Product. 
Shrinkwrap License (SR). With respect to Software that contains elements 
provided by third party suppliers, End user may install and use the Software in 
accordance with the terms and conditions of the "shrinkwrap" or "clickwrap" 
license accompanying the Software ("Shrinkwrap License"). The text of the 
Shrinkwrap License will be available from Avaya upon End User's request (see 
"Copyright" below for more information).

Copyright 
Except where expressly stated otherwise, the Product is protected by copyright 
and other laws respecting proprietary rights. Unauthorized reproduction, 
transfer, and or use can be a criminal, as well as a civil, offense under the 
applicable law.

Third-party Components
Certain software programs or portions thereof included in the Product may 
contain software distributed under third party agreements ("Third Party 
Components"), which may contain terms that expand or limit rights to use 
certain portions of the Product ("Third Party Terms"). Information identifying 
Third Party Components and the Third Party Terms that apply to them is 
available on the Avaya Support Web site:
http://support.avaya.com/ThirdPartyLicense/ 

Preventing Toll Fraud
"Toll fraud" is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or is not working on your company's behalf). Be aware 
that there might be a risk of toll fraud associated with your system and that, if 
toll fraud occurs, it can result in substantial additional charges for your 
telecommunications services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical 
assistance or support, call Technical Service Center Toll Fraud Intervention 
Hotline at +1-800-643-2353 for the United States and Canada. For additional 
support telephone numbers, see the Avaya Support Web site:
http://www.avaya.com/support 

Providing Telecommunications Security
Telecommunications security (of voice, data, and/or video communications) is 
the prevention of any type of intrusion to (that is, either unauthorized or 
malicious access to or use of) your company's telecommunications equipment 
by some party.
Your company's "telecommunications equipment" includes both this Avaya 
product and any other voice/data/video equipment that can be accessed by this 
Avaya product (that is, "networked equipment").
An "outside party" is anyone who is not a corporate employee, agent, 
subcontractor, or is not working on your company's behalf. Whereas, a 
"malicious party" is anyone (including someone who might be otherwise 
authorized) who accesses your telecommunications equipment with either 
malicious or mischievous intent.
Such intrusions might be either to/through synchronous (time-multiplexed 
and/or circuit-based), or asynchronous (character-, message-, or 
packet-based) equipment, or interfaces for reasons of:

• Utilization (of capabilities special to the accessed equipment)
• Theft (such as, of intellectual property, financial assets, or toll 

facility access)
• Eavesdropping (privacy invasions to humans)
• Mischief (troubling, but apparently innocuous, tampering)
• Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there might be a risk of unauthorized intrusions associated with 
your system and/or its networked equipment. Also realize that, if such an 
intrusion should occur, it might result in a variety of losses to your company 
(including but not limited to, human/data privacy, intellectual property, material 
assets, financial resources, labor costs, and/or legal costs).

Responsibility for Your Company’s Telecommunications Security
The final responsibility for securing both this system and its networked 
equipment rests with you — Avaya’s customer system administrator, your 
telecommunications peers, and your managers. Base the fulfillment of your 
responsibility on acquired knowledge and resources from a variety of sources 
including but not limited to:

• Installation documents
• System administration documents
• Security documents
• Hardware-/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

http://www.avaya.com/support
http://www.avaya.com/support
http://support.avaya.com/LicenseInfo/
http://support.avaya.com/ThirdPartyLicense/


To prevent intrusions to your telecommunications equipment, you and your 
peers should carefully program and configure:

• Your Avaya-provided telecommunications systems and their 
interfaces

• Your Avaya-provided software applications, as well as their 
underlying hardware/software platforms and interfaces

• Any other equipment networked to your Avaya products

TCP/IP Facilities
Customers might experience differences in product performance, reliability and 
security depending upon network configurations/design and topologies, even 
when the product performs as warranted.

Standards Compliance
Avaya Inc. is not responsible for any radio or television interference caused by 
unauthorized modifications of this equipment or the substitution or attachment 
of connecting cables and equipment other than those specified by Avaya Inc. 
The correction of interference caused by such unauthorized modifications, 
substitution or attachment is the responsibility of the user. Pursuant to Part 15 
of the Federal Communications Commission (FCC) Rules, the user is 
cautioned that changes or modifications not expressly approved by Avaya Inc. 
might void the user’s authority to operate this equipment.

Federal Communications Commission Statement

Part 15:

Canadian Department of Communications (DOC) Interference Information
This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 
Canada.
This equipment meets the applicable Industry Canada Terminal Equipment 
Technical Specifications. This is confirmed by the registration number. The 
abbreviation, IC, before the registration number signifies that registration was 
performed based on a Declaration of Conformity indicating that Industry 
Canada technical specifications were met. It does not imply that Industry 
Canada approved the equipment.

European Union Declarations of Conformity

Avaya Inc. declares that the equipment specified in this document bearing the 
"CE" (Conformité Europeénne) mark conforms to the European Union Radio 
and Telecommunications Terminal Equipment Directive (1999/5/EC), including 
the Electromagnetic Compatibility Directive (89/336/EEC) and Low Voltage 
Directive (73/23/EEC).
Copies of these Declarations of Conformity (DoCs) can be obtained by 
contacting your local sales representative and are available on the Avaya 
Support Web site:
http://www.avaya.com/support 

Trademarks
Avaya is a registered trademark of Avaya Inc.
Aura, OCTEL, ARIA, SERENADE, and INTUITY AUDIX are registered 
trademarks of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners.

Downloading documents
For the most current versions of documentation, go to the Avaya Support Web 
site:
http://www.avaya.com/support 

COMPAS
This document is also available from the COMPAS database. The COMPAS ID 
for this document is 142584.

Avaya support
Avaya provides a telephone number for you to use to report problems or to ask 
questions about your product. The support telephone number 
is 1-800-242-2121 in the United States. For additional support telephone 
numbers, see the Avaya Support Web site:
http://www.avaya.com/support 

Note: This equipment has been tested and found to comply with 
the limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to 
correct the interference at his own expense.

http://www.avaya.com/support/
http://www.avaya.com/support/
http://www.avaya.com/support/
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Preface

This section contains the following topics:

● Purpose on page 7

● Audience on page 8

● Related documents on page 8

● Availability on page 8

Purpose
This guide provides information about installing the Web Client software. You can install Web 
Client software on the server for Modular Messaging Web Client. 

This guide contains the following sections:

Note:
Note: This guide does not provide information about installing the Web Client software 

on Avaya AuraTM System Platform. For information about installing Web Client 
software on system platform, see Installing Avaya Modular Messaging on a 
Single Server Configuration in the Modular Messaging Documentation library

Section Description

Introduction on page 9 Explains the basic architecture of 
Avaya Modular Messaging and 
Modular Messaging Web Client

Prerequisites on page 13 Explains prerequisites for the hardware 
and software required for the Web 
Client server and the Modular 
Messaging sytem

Installation on page 19 Provides step-by-step installation 
procedures

Upgrades on page 31 Provides step-by-step upgrade 
procedures



 Preface
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Audience
This guide is intended primarily for those who install and configure Modular Messaging Web 
Client.

Related documents
The following are related documents in the Modular Messaging documentation set:

● Modular Messaging Concepts and Planning Guide

● Modular Messaging for the Avaya Message Storage Server (MSS) Installation and 
Upgrades

● Messaging Application Server Administration Guide for Avaya Modular Messaging with the 
Avaya MAS and MSS

● Modular Messaging Web Subscriber Options Server Installation

● Installing Avaya Modular Messaging on a Single Server Configuration

● Modular Messaging Web Client Administration and Maintenance

Note:
Note: You can find all of these documents in the Modular Messaging Documentation 

library, with the exception of the last bullet item. Documentation for Modular 
Messaging Web Client is included on the Modular Messaging Web Client 
software media.

Availability
Copies of this document are available from one or both of the following sources: 

Note:
Note: There is no charge to download documents through the Avaya Web site.

● Avaya online support Web site:

http://support.avaya.com 

● Modular Messaging Web Client software media

http://support.avaya.com
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Chapter 1: Introduction 

This section introduces the architecture of Modular Messaging and the components that make 
up a Modular Messaging system. This section includes the following topics:

● Messaging application server on page 9 

● Message Storage Server on page 9

● Web Client server on page 10

● Web Subscriber Options server on page 10

Messaging application server
The system must include at least one messaging application server (MAS), but might include 
several, depending on system capacity. One MAS or a group of MASs is referred to as a voice 
mail domain.

The MAS software can reside on a customer-provided computer or on Avaya-provided 
hardware with a Windows operating system. Avaya-provided hardware can be a server in the 
S3500, S8730, or S8800 1U family. 

Note:
Note: Avaya does not support S3400-family server hardware from Release 5.0.

For information about installing the MAS software, see Modular Messaging for the Avaya 
Message Storage Server (MSS) Installation and Upgrades on the Modular Messaging 
Documentation library. For information about administering the MAS, see Messaging 
Application Server Administration Guide for Avaya Modular Messaging with the Avaya MAS and 
MSS in the Modular Messaging Documentation library.

Message Storage Server
In order to use Modular Messaging Web Client, the system must include one Avaya Message 
Storage Server (MSS). The MSS software resides on an Avaya message server platform with a 
LINUX operating system. The Avaya message server can be a server in the S3500, S8730, or 
S8800 1U family.

Note:
Note: Avaya does not support S3400-family server hardware from Release 5.0.
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For information about installing the MSS software, see the Modular Messaging for the Avaya 
Message Storage Server (MSS) Installation and Upgrades in the Modular Messaging 
Documentation library. For information about administering the MSS, see the online Help that 
comes with the software or the MSS administration topics in the Modular Messaging 
Documentation library.

Web Client server
The Modular Messaging Web Client server supports access to client mailboxes on the MSS. 
The server provides this access through the corporate local area network (LAN). 

Note:
Note: The Web Client server does not support access to other voice messaging 

systems, such ARIA, SERENADE, or INTUITY AUDIX.

A Web Client server can support multiple Modular Messaging systems.

The Web Client server software can reside on a customer-provided computer or on 
Avaya-provided hardware. Avaya-provided hardware can be a server in the S3500, S8730, or 
S8800 1U family.

Note:
Note: Avaya does not support S3400-family server hardware from Release 5.0.

! Important:
Important: You can install Web Client on the same server that is being used for Web 

Subscriber Options. However, you cannot install Web Client on the MAS or on the 
same server with other MAS applications that belong to the voice mail domain. 
For example, you cannot install Web Client on the tracing server or on a 
supplementary server. The system does not function properly if Web Client is 
installed on a server that belongs to the voice mail domain.

For information about administering the Web Client server, see Modular Messaging Web Client 
Administration and Maintenance on the Modular Messaging Web Client software media.

Web Subscriber Options server
This server supports access to Modular Messaging Web Subscriber Options. The Web 
Subscriber Options server obtains and updates subscriber information stored on the MAS.

A Web Subscriber Options server can support a single Modular Messaging voice mail domain.

The Web Subscriber Options server software can reside on the following servers:



Web Subscriber Options server
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● Messaging application server

● Web Client server

● A stand-alone server

This server can be a customer-provided computer or Avaya-provided hardware. 
Avaya-provided hardware can be a server in the S3500, S8730, or S8800 1U family

Note:
Note: Avaya does not support S3400-family server hardware from Release 5.0.

For information about installing the Web Subscriber Options server, see Modular Messaging 
Web Subscriber Options Server Installation in the Modular Messaging Documentation library.
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Chapter 2: Prerequisites

This section describes the prerequisites that must be met before you can install the Web Client 
server software.

As the installer, you must have an administrative log-in account and password for the Web 
server that you will use for Web Client. You must also have working knowledge of Windows 
Server 2003 administration.

This section contains the following topics:

● Hardware prerequisites on page 13

● Software prerequisites on page 14

● System prerequisites on page 16

● Prerequisite testing on page 17

Hardware prerequisites

! Important:
Important: The Web Client server software can reside on a customer-provided computer or 

on Avaya-provided hardware. Avaya-provided hardware can be a server in the 
S3500, S8730, or S8800 1U family. You can install Web Client on the same 
server that is being used for Web Subscriber Options. However, you cannot install 
Web Client on the messaging application server (MAS) or on the same server 
with other MAS applications that belong to the voice mail domain. For example, 
you cannot install Web Client on the tracing server or on a supplementary server. 
The system does not function properly if Web Client is installed on a server that 
belongs to the voice mail domain.

Note:
Note: Avaya does not support S3400-family server hardware from Release 5.0.

If you are using a customer-provided computer for the Web server, verify that the computer 
meets the following hardware requirements:

● 2.0-gigahertz (GHz) Pentium IV or equivalent processor

● 1 gigabyte (GB) RAM

● 80 gigabytes (GB) of available space on the hard disk drive

This space must be in Windows NT file system format.
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Note:
Note: Only 350 MB of space is required for the software alone, but 80 GB is required for 

the software to operate in the customer environment.

● Modem

● DVD-ROM drive

● Network interface card (NIC)

The NIC is required in the server to connect to the corporate local area network (LAN).

● LAN connectivity with a speed of 100 megabits per second (Mbps)

Before you install and administer the Modular Messaging Web Client server, ensure that the 
hardware is installed on the network at the customer site. For more information about installing 
Avaya hardware, see Modular Messaging for the Avaya Message Storage Server (MSS) 
Installation and Upgrades in the Modular Messaging Documentation library.

Software prerequisites
Verify that the Web Client server and the client computers meet the following software 
prerequisites.

Server software
You need the Modular Messaging Web Client software media to install the Web Client server 
software.

If you are using a customer-provided computer for the Web server, verify that the computer 
meets the following software requirements:

● One of the following versions of Windows Server 2003, including Service Pack 2 (SP2)

- Web Edition
- Standard Edition

! Important:
Important: If you install the Web Client for users who will select a multibyte display language 

on their local machines, keep the following guidelines in mind:

● You must install the Windows East Asian language pack on the server in order for 
the system to display languages properly on the client machines. 
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● If you change your regional and language options in Windows Server 2003 to a 
multibyte language, the Web Client might display corrupt characters on the client 
machines. For more information about regional and language options, see your 
Windows Server 2003 documentation.

● Internet Information Services (IIS) 6.0

CAUTION:!

CAUTION: After you install Windows Server 2003, verify that the server is running in IIS 6.0 
and not IIS 5.0 isolation mode. For more information about verifying your IIS 
settings, see Verifying Internet Information Services on page 33. For information 
about verifying your port settings for IIS, see Verifying port settings on page 25.

● One of the following versions of Internet Explorer

- Internet Explorer 6 with SP1
- Internet Explorer 7
- Internet Explorer 8

● Virus protection software with the latest updates (recommended)

CAUTION:!

CAUTION: Avaya recommends that you perform the following actions:

● Install the Web Client server software directly on a server without using Terminal 
Services.

● Verify that any applicable drivers for your Ethernet LAN are up-to-date on your 
server. If they are not, you might not be able to proceed with your installation or 
upgrade of the Web Client server software.

● Save an image of the server before you start the installation. This image should 
include all network settings, the required Windows operating system, service 
packs, and other software. If it becomes necessary, you can quickly restore the 
server to its initial configuration.

● Install and routinely update Windows security patches to protect the operating 
system from known security weaknesses. For recommended Microsoft service 
packs and security updates, see www.avaya.com/support. For more information 
on security, see "System security" on the Modular Messaging Documentation 
library.

Client software
Verify that the following software is installed on the client computers:

● One of the following versions of Microsoft Windows

- Windows XP Professional with SP2
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- Windows XP Professional N
- Windows Vista Business Edition
- Windows Vista Enterprise Edition

● One of the following versions of Internet Explorer

- Internet Explorer 6 with SP1
- Internet Explorer 7
- Internet Explorer 8

CAUTION:!

CAUTION: Users who log on to Web Client with an unsupported browser might receive a 
one-time warning message. If users are allowed to log on with an unsupported 
browser, Web Client features might not function properly.

System prerequisites
The following table describes minimum Modular Messaging system requirements for use with 
the Web Client.

Avaya recommends that Modular Messaging is completely installed and working properly 
before you begin the installation of the Web Client server. For information about installing the 
Modular Messaging system, see Modular Messaging for the Avaya Message Storage Server 
(MSS) Installation and Upgrades in the Modular Messaging Documentation library.

In addition, the Message Storage Server (MSS) must have the following ports enabled to 
communicate with the Web Client server: 

● Port 25 for Simple Mail Transfer Protocol (SMTP)

● Port 389 for Lightweight Directory Access Protocol (LDAP), if you want to use the address 
look-up features of LDAP

For more information about the Modular Messaging system, see Modular Messaging Concepts 
and Planning Guide in the Modular Messaging Documentation library. For information about 
enabling ports on the MSS, see Modular Messaging for the Avaya Message Storage Server 
(MSS) Installation and Upgrades in the Modular Messaging Documentation library.

Message server type Minimum release

Avaya Modular Messaging system 5.2

Message Storage Server (MSS) 5.2
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Prerequisite testing
If the Modular Messaging system is installed, you can verify that the MSS and the Web Client 
server are networked correctly.

From the Web server, ping the MSS server:

1. Click Start > Run.

2. Type cmd, and press Enter.
3. In the cmd.exe window, type ping <IP address>, and press Enter. 

Use the IP address or server name of the MSS. If the ping to the MSS fails, see your 
network administrator.
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Chapter 3: Installation

This section describes how to install Web Client server software, verify the installation, and 
complete initial administration tasks on the Web client server. This section also describes how 
to uninstall or remove Web client server software. This section includes the following topics:

● Installing Web Client server software Release 5.0 on page 19

● Upgrading Web Client server software from Release 5.0 to Release 5.1 on page 21

● Verifying the installation on page 22

● Configuring the security options on page 25

● Completing initial administration on page 26

● Installing Web Client online help on page 28

● Uninstalling Web Client server software on page 28

● Removing Web Client server software on page 29

Installing Web Client server software Release 5.0
Note:

Note: If you have a previous version of Modular Messaging Web Client installed on a 
server and want to upgrade to Web Client Release 5.0, follow the procedures in 
Chapter 4: Upgrades on page 31. If you want to upgrade to Web Client Release 
5.1 or 5.2, the system must be running Modular Messaging Web Client Release 
5.0. For complete instructions on how to upgrade to Modular Messaging Release 
5.1 or 5.2 using Modular Messaging Upgrade application, see the Modular 
Messaging Upgrade application online help. You can download the Modular 
Messaging Upgrade application for Release 5.1 and Release 5.2 from http://
support.avaya.com.

To start the installation:

1. Insert the Modular Messaging Web Client software media into your server. The system 
displays a screen with the following options:

● Avaya Modular Messaging Web Client 5.0 Install. Use this option to install the Web 
Client Release 5 software. Go to Step 2 of this procedure.

● Uninstall Avaya Modular Messaging Web Client 5.0 (Data will be retained). Use 
this option when you want to uninstall the the server software but retain the directory of 
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administered Web Client data. For more information, see Uninstalling Web Client 
server software on page 28.

● Remove Avaya Modular Messaging Web Client 5.0 (All data will be lost). Use this 
option when you want to remove the server software and the directory of administered 
Web Client data. For more information, see Removing Web Client server software on 
page 29.

● Avaya Modular Messaging Web Client 5.0 Installation Guide (Requires Adobe 
Acrobat Reader). Use this option to view this installation guide.

● Avaya Modular Messaging Web Client 5.0 Administration Guide (Requires 
Adobe Acrobat Reader). Use this option to view information about administering the 
Web Client server. For more information, see Completing initial administration on 
page 26.

Note:
Note: If the Autorun does not run, browse to the default.htm file on the CD-ROM 

and double-click the file. The system displays a screen with the above mentioned 
options

2. Select Avaya Modular Messaging Web Client 5.0 Install.
The rest of the installation process is described in the following table. In this table, each row 
relates to a particular dialog box you see as the installation progresses. The information in each 
row describes how to complete the fields in that dialog box and then proceed to the next dialog 
box.

Use the following table to complete the Install dialog boxes.

Dialog box Required action Notes 

Read Me file Click Continue. ———

Avaya Modular 
Messaging Web Client 
Installation (Welcome 
dialog box)

Click Next. ———

Software License 
Agreement

Click I Agree. ———

Modular Messaging 
Web Client Installation 
(Tell Me About dialog 
box)

1. Review any topics of interest.
2. In the body of the dialog box, 

click Next. 
3. Select Continue With Install.
4. At the bottom of the dialog box, 

click Next.

You can view information 
about the 
documentation, or you 
can continue the 
installation.
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Upgrading Web Client server software from Release 5.0 to 
Release 5.1

If you are upgrading from Release 5.0 to Release 5.1, use the Modular Messaging 5.1 Upgrade 
application. For more information about how to use the Modular Messaging 5.1 Upgrade 
application for upgrading your Modular Messaging software, see the Modular Messaging 5.1 
Upgrade application online help. You can download the Modular Messaging 5.1 Upgrade 
application from http://support.avaya.com.

Modular Messaging 
Web Client Installation 
(Select Destination 
Directory dialog box)

1. Accept the default destination 
folder on the C: drive, or navigate 
to a different location. 

2. Click Next.

Modular Messaging 
Web Client Installation 
(Backup Replaced 
Files? dialog box)

Select Yes, and click Next. Avaya recommends that 
you complete a system 
backup before starting 
the installation.

Select Program Group Leave the default as is, and click 
Next.

———

Modular Messaging 
Web Client Installation 
(Ready to Install dialog 
box)

Click Next. ———

Installing Wait for the system to display the 
next dialog box.
Caution: If you see any messages 
asking whether you want to 
overwrite newer files, click No.

———

Modular Messaging 
Web Client Installation 
(Installation 
Completed! screen)

1. Click Finish.
2. To restart the server, click OK.
3. After the restart completes, log 

on again to the server. 
The system registers several 
Web Client files. Wait for file 
registration to complete.

———

Dialog box Required action Notes 
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Upgrading Web Client server software from Release 5.0 or 
Release 5.1 to Release 5.2

If you are upgrading from Release 5.0 or Release 5.1 to Release 5.2, use the Modular 
Messaging 5.2 Upgrade application. For more information about how to use the Modular 
Messaging 5.2 Upgrade application for upgrading your Modular Messaging software, see the 
Modular Messaging 5.2 Upgrade application online help. You can download the Modular 
Messaging 5.2 Upgrade application from http://support.avaya.com.

Verifying the installation
This section includes the following topics:

● Verifying Web Client components on page 22

● Running Install Verify Test (Ivy) on page 23

● Verifying port settings on page 25

Verifying Web Client components
When you installed Modular Messaging Web Client, the system installed all the components 
needed to run, configure, and monitor the use of the application, including:

● Modular Messaging Web Client. Users gain access to this interface by logging on to their 
mailboxes through the URL for the Web Client server:

http://<server name>/webmsg

Note:
Note: Users of this interface can select the language in which they want the interface to 

display.

● Modular Messaging Web Client Administration and Maintenance tools. 
Administrators use this interface to configure and maintain the Web Client server. For 
more information about this interface, see Completing initial administration on page 26, the 
online Help system contained within the administration interface, or Modular Messaging 
Web Client Administration and Maintenance on the Modular Messaging Web Client 
software media.

Note:
Note: The administration interface is available in English only.
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● Modular Messaging Web Client Tools program group. You can use these tools to verify 
the installation and connectivity of the Web Client server and to maintain the server. You 
can access these tools from the Start menu of the Web Client server by clicking Programs 
> Avaya Modular Messaging Web Client Tools. Tools include the following:

● Connectivity Test. You can use this tool to verify connectivity between message 
servers and the Web server, after you have added message servers. For more 
information, see Configuring and verifying the message servers on page 27.

● Install Verify Test - Ivy. You can use this test to verify and diagnose the installation of 
the Web Client server. For more information, see Running Install Verify Test (Ivy) on 
page 23.

● Reset Web Server. If you reset the Web server, the Web server stops and then 
re-starts. This might be required, for example, if you are having problems with IIS.

Note:
Note: You can also test for IIS problems and reset the Web server through the Web 

Client Administration pages. For more information, see the online Help system 
contained within the administration interface or Modular Messaging Web Client 
Administration and Maintenance on the Modular Messaging Web Client software 
media.

● Start Web Server. You can start the Web server after you complete any needed 
system maintenance.

● Stop Web Server. You can stop the Web server to perform system maintenance.

● UMLog Viewer. Technical support representatives can use this log viewer to 
troubleshoot problems with your system.

Running Install Verify Test (Ivy)

About Ivy
Use the Install Verify Test (Ivy) to verify and diagnose the Modular Messaging Web Client 
installation. Ivy uses system data to create a report in plain ASCII format. You can do the 
following:

● Save and print the Ivy report.

● Change the filter for viewing data.

● Create different baselines for comparisons.

When you open Ivy from the Modular Messaging Web Client Tools program group, the tool 
starts automatically. The tool checks each Modular Messaging Web Client file against the 
database for the following:

● File name

● Location
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● Size

● Date

● Version

● Windows registry entry

About the Ivy report
The status bar in the Install Verify window displays each file name as that file is being checked.

When the verification is complete, the window displays the Ivy report. The default is to create a 
report that shows only errors and warnings. You can change the information that is shown by 
clicking the stoplights on the toolbar. Red shows only errors, yellow is the default that shows 
both errors and warnings, and green shows all files. Errors appear against a red background, 
and warnings appear against a yellow background.

The Ivy report is made up of a row of tabs. If you enable the default that shows both errors and 
warnings and the fields of a selected tab are empty, no errors or warnings are present.

The tool displays the information contained in the Ivy database on the first line for each file and 
the information found on the Web server on the second line. The tool displays only information 
that differs from one database to another. A blank column on the second line indicates that the 
information matches.

When you review a report, you might notice some warnings for differences that you do not need 
to address. For example, a newer version of a system file present on the server is usually not 
replaced with an older version, but the Ivy report displays the difference. You can exclude these 
differences from future Ivy reports when you set the baseline. You should address all errors that 
the system displays in a report.

You can create a baseline of the Ivy report either from the Tools menu or from the magnifying 
glass icon on the toolbar. A baseline file contains information about the Ivy database and 
system differences at the time the baseline was created. 

Establishing a baseline report
To establish a baseline report:

1. On the Web Client server, click Start > Programs > Avaya Modular Messaging > Web 
Client Tools > Install Verify Test - Ivy.

The system checks the program files. The process might take a few minutes.

2. Click each tab in the Ivy window, and verify that no errors exist. Errors appear in red.

3. On the Tools menu, click Make Baseline.

4. Specify saving the file to the default folder, and click Save.

5. In the Select Output dialog box, select All Entries, and click OK.

6. When you are ready to close Ivy, click File > Exit.



Configuring the security options

Web Client for Modular Messaging Release 5.2 Server Installation and Upgrades November 2009 25

 

The baseline file is not used automatically when Ivy creates future reports. To view the 
differences between an Ivy report and the baseline, on the Tools menu, click Compare to 
Baseline. The system displays a new report that shows only the errors and warnings that are 
not in the baseline file.

Verifying port settings
The Web Client installation process creates the virtual Web directory webmsg under the Default 
Web Site of Internet Information Services (IIS). The Default Web Site uses port 80 as the default 
Transmission Control Port (TCP) port. If you are using the default port and port 80 is closed on 
the Web server, you must open port 80 on the Web server. To open port 80 on the Web server:

1. Click Start > Run, and type secpol.msc.

The system launches the Local Security Policy snap-in.

2. In the left pane, under Security Settings, click IP Security Policies on Local Computer.
3. Right-click Block TCP 80 Filter, and click unassign.

The Policy Assign column displays no.

Configuring the security options
Use the procedure described in this section to configure the security settings. Complete the 
following steps to change the security settings:

● Navigate to the webmsg\ADMIN directory on the server where you installed the Web 
Client.

● In the command prompt, type wmWebAdmin2k3.exe CWA "C:\Program Files\Avaya\
webmsg" webmsg. 

The system displays Web Client Configuration dialog box. 

1. The Web Client Configuration dialog box displays the following security options:

● None. This options supports only HTTP.

● None or SSL. This options supports both HTTP and HTTPS.

● SSL Only. This options supports only HTTPS.

2. Click None or SSL or SSL Only.

These options enable secure communication.

3. Select one of the following:
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● Create a new certificate

The system creates a new certificate file with .pfx extension. You must select this option if 
you want the system to create a certificate.

● Select an existing certificate

Browse to select an existing certificate file with .pfx extension. You must select this option 
if you want to use an existing certificate.

4. 4. In PFX Password field, enter the password of the PFX certificate.

5. Click Next.
6. Click Finish when the configuration is complete.

Completing initial administration
After you successfully install the Web Client server and verify the installation, you can complete 
basic administration tasks from the Web Client administration interface. 

Note:
Note: Before you administer the Modular Messaging Web Client server, the server must 

be installed on the network at the customer site.

To log on to the administration interface:

1. In your browser, enter the following URL:

http://<server name>/webmsg/admin
(for example, http://uccweb.rnd.avaya.com/webmsg/admin).

The system displays the Administration and Maintenance logon page.

2. In the Log On field, type admin, and type the default password, admin1.

3. Click Log On.

The system displays the Administration and Maintenance page.

Initial administration tasks that you should complete include the following:

● Configuring and verifying the message servers on page 27

● Configuring Web Client options and settings on page 27

For more information about administration and maintenance tasks completed within the Web 
Client administration interface, see the online Help system contained within the administration 
interface or Modular Messaging Web Client Administration and Maintenance on the Modular 
Messaging Web Client software media.
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Configuring and verifying the message servers
From the Message Servers page of the Web Client administration interface, you must configure 
the message servers that will communicate with the Web Client server. To configure message 
servers, follow the instructions in "Message Servers page" in the administration online Help 
system or in Modular Messaging Web Client Administration and Maintenance on the Modular 
Messaging Web Client software media.

You can use the Connectivity Test to verify the connectivity between the Web Client server and 
the message servers that you administered for the Web Client. The Connectivity Test verifies 
the name and IP address of the Web Client server and where the Web Client resides. The test 
also checks the following criteria:

● The Web Client server is configured for network access.

● Internet Information Services (IIS) is running on the Web server.

● A connection to the message servers exists.

To run the Connectivity Test:

1. On the Web Client server, click Start >Programs > Avaya Modular Messaging Web 
Client Tools > Connectivity Test.

2. To test all the message servers that you configured for the Web Client, click Test All.
The tool automatically tests connectivity to each server.

Configuring Web Client options and settings
From the Options and Settings page of the Web Client administration interface, you can 
configure parameters that affect how subscribers use the Web Client. For example, you can 
configure the following parameters:

● Web server timeout

● Corporate logo

● Web Link Control

● Feature options such as message notification and subject edit

● Message creation options such as message text and attachments

● Message options such as message copy and paste

● Search options

● Voice player options

● Restricted English version of Web Client user interface

● Message of the day
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● Executable scripting in messages

For more information about these parameters and how to configure them, see the "Options and 
Settings page" section in the administration online Help or in Modular Messaging Web Client 
Administration and Maintenance on the Modular Messaging Web Client software media.

Installing Web Client online help
After you successfully install the Web Client server and verify the installation, you can install 
Web Client online help.

To install the Web Client online help for Release 5.1:

1. Run MM51WCHelpUpdate.exe from the Patch folder.

2. System displays the installation progress dialog.

3. On completion, system displays Installation successfully complete dialog box.

4. Click OK to complete the installation.

To install the Web Client online help for Release 5.2:

5. Run MM52WCHelpUpdate.exe from the Patch folder.

6. System displays the installation progress dialog.

7. On completion, system displays Installation successfully complete dialog box.

8. Click OK to complete the installation.

Uninstalling Web Client server software
You uninstall the Web Client server software when you want to uninstall the software but retain 
the directory of administered Web Client data. The system stores this data at C:\Program 
Files\Avaya\webmsg\Data. You should use this method when you want to uninstall and 
then reinstall the server software.

To uninstall Modular Messaging Web Client server software:

1. On the Web Client server, click Start > Settings > Control Panel > Add/Remove 
Programs.

2. Select Avaya Modular Messaging Web Client from the list of programs.

3. Click Change/Remove.
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4. Proceed with the uninstall of the Modular Messaging Web Client software as you would to 
uninstall any program through Windows. 

The system uninstalls the Web Client server software and retains your directory of 
administered Web Client data.

Note:
Note: You can also uninstall Web Client server software by using the Modular 

Messaging Web Client software media:

1. Insert the Modular Messaging Web Client software media.

2. Select Uninstall Avaya Modular Messaging Web Client 4.0 (Data will be 
retained).

Removing Web Client server software
You remove the Web Client server software when you want the system to remove the server 
software and the directory of administered Web Client data. The system stores this data at C:\
Program Files\Avaya\webmsg\Data. You should use this method if you are planning to 
use the server for a purpose other than the Web Client.

To remove Modular Messaging Web Client server software:

1. Insert the Modular Messaging Web Client software media.

2. Select Remove Avaya Modular Messaging Web Client 4.0 (All data will be lost).
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Chapter 4: Upgrades

This section describes how to upgrade from an existing installation of Web Client to Web Client 
Release 5.2. 

! Important:
Important: If you want to upgrade to Web Client Release 5.1 or 5.2, the system must be 

running Modular Messaging Web Client Release 5.0. For complete instructions 
on how to upgrade to Modular Messaging Release 5.1 or 5.2 using Modular 
Messaging Upgrade application, see the Modular Messaging Upgrade application 
online help. You can download the Modular Messaging Upgrade application for 
Release 5.1 and Release 5.2 from http://support.avaya.com.

This section includes the following topics:

● Upgrading Web Client on S3500 server, S8730 server, S8800 1U server or 
customer-provided computer on page 31

Note:
Note: Avaya does not support S3400-family server hardware from Release 5.0.

Upgrading Web Client on S3500 server, S8730 server, 
S8800 1U server or customer-provided computer

When you upgrade an existing installation of Web Client to Web Client Release 5.0 on S3500 
server, S8730 server, S8800 1U server or customer-provided computer, complete steps in the 
following sequence:

! Important:
Important: If you are using a customer-provided computer, you might need to upgrade your 

hard drive before upgrading to Web Client Release 5. In order for the Web Client 
software to operate properly, your server must have at least 80 GB of available 
space on the hard disk drive. If the hard disk drive of your server is smaller than 
80 GB, you must replace the hard drive or add a hard drive to the server before 
you begin the upgrade process.

1. Back up Web Client data. For more information, see Backing up Web Client data on 
page 32.



Chapter 4: Upgrades

32 Web Client for Modular Messaging Release 5.2 Server Installation and Upgrades November 2009

 

2. Uninstall existing version of the Web Client. For more information, see Uninstalling Web 
Client on page 32.

3. Upgrade the server operating system to Windows Server 2003. For more information, see 
Installing server operating system on page 33.

4. Verify the server settings for Internet Information Services (IIS). For more information, see 
Verifying Internet Information Services on page 33.

5. Install Web Client Release 5 server software. For more information, see Installing Web 
Client server software Release 5.0 on page 19.

6. Restore Web Client data, if needed. For more information, see Restoring Web Client 
data on page 33.

7. Verify the installation. For more information, see Verifying the installation on page 22.

8. Complete initial administration tasks. For more information, see Completing initial 
administration on page 26.

This section includes the following topics:

● Backing up Web Client data on page 32

● Uninstalling Web Client on page 32

● Installing server operating system on page 33

● Verifying Internet Information Services on page 33

● Restoring Web Client data on page 33

Backing up Web Client data
● Copy the Web Client Data directory (C:\Program Files\Avaya\webmsg\Data) to a 

USB storage device, such as a flash drive, memory stick, or equivalent.

Uninstalling Web Client
Before you can install Web Client Release 5.2 software, you must uninstall your existing Web 
Client software. 

! Important:
Important: When you uninstall your existing Web Client installation, the system does not 

remove your directory of administered Web Client data. The system stores this 
data at C:\Program Files\Avaya\webmsg\Data. Avaya recommends that 
you back up this directory as a precaution. After you uninstall Web Client, leave 
the data directory intact.
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CAUTION:!

CAUTION: Web Client Release 5.2 works only with Windows Server 2003. If you uninstall an 
earlier version of the Web Client and cannot upgrade your server to Windows 
2003, you cannot proceed with the Web Client Release 5.2 installation.

To uninstall an existing version of the Web Client, follow the procedure in Uninstalling Web 
Client server software on page 28.

Installing server operating system 
For required server software, see Server software on page 14.

For information about how to install Windows Server 2003, see your Windows documentation.

Verifying Internet Information Services
After you install Windows Server 2003, verify that the server is running in IIS 6.0 mode and not 
IIS 5.0 isolation mode.

To verify the IIS settings of the server:

1. On the server, open IIS Manager.

2. In the pane on the left side of the interface, expand YourComputer (local computer) if it 
is not already expanded.

3. Right-click on Web Sites, and click Properties.

4. Click the Service tab, and verify that Run WWW Service in IIS 5.0 isolation mode is not 
selected.

5. If you clear the field, click Apply, and close IIS Manager.

Note:
Note: If the system asks you if you want to reset IIS, click Yes.

Restoring Web Client data

After you install the Web Client server software, copy your Web Client Data directory from your 
USB storage device back to C:\Program Files\Avaya\webmsg\Data.
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